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Mainstreaming, the Americans with Disabilities Act, the Rehabilitation Act, inclusion, and equal employment
have all had a profound influence on public awareness of handicapped persons, including Deaf persons.

Deafness is often referred to as an invisible handicap since the physical signs of the handicap are not
apparent. A dramatic increase in its public awareness resulted from the Deaf President Now (DPN) move-
ment. When the presidential vacancy at Gallaudet University was filled with a hearing person even though
equally qualified Deaf persons existed, the DPN was born and a revolution took place. Because of national
and international media coverage of the DPN protest, millions of persons around the world became aware of
deafness and the Deaf culture. Interest in American Sign Language (ASL, the language of the Deaf culture)
increased in part because voiced interpretation of the protests were provided.

Until the mid 1960’s, ASL was not seen as a true language. It was only considered to be a gestured form of
English. The work of William Stokoe and his associates at Gallaudet University in 1965 lead to the identifi-
cation of the elements in ASL which comprised its content, form, and function. These three features are said
to be the minimal constituents of any language.

Ursula Bellugi has continued this work by investigating the processing of sign language in the language
center of the brain (left hemisphere), the documentation of the movements which give unique meaning to a
sign or sign movement, and the mapping of the processing of ASL in the brains of Deaf persons who have
had strokes. The research has confirmed that ASL is a true language even though it is unlike English in its
grammar and, unlike other languages, it has no written or spoken form.

Laws mandating accessibility to mainstream services and education for handicapped persons and their
parents have necessitated the development
of effective ways to implement change. The need for hearing persons to learn ASL has grown and there is an
increasing need for professional
sign interpreters who can understand and use ASL in business, service industries, and schools.

The recognition of ASL as a real language and the greater visibility and involvement of Deaf persons in
society has led to an increased interest in learning ASL by hearing persons. The traditional instructional
format for teaching ASL has been watch me and imitate. Because of limited contact with Deaf signers and
minimal practice outside of class, students in these classes often exhibit poor retention of sign vocabulary.

Why HyperSign?

Many texts and videotaped lexicons of ASL exist. The texts are one dimensional and do not adequately
illustrate the motion or the changes in meaning which facial expressions add to the sign. While video tapes
add motion and the facial expressions, their inherent linear nature is a significant detriment to their effective
use in learning ASL.

People learn and retain best what they need and what serves a purpose in their daily lives. When sign
language is taught to hearing adults, one method used is to teach vocabulary in categories. When these
same adults go to use this vocabulary either with their own hearing-impaired children or with Deaf adults,
their communication is limited to only known vocabulary.

Chapter 1
Introduction

In this manual, “deaf” is capitalized when referring to cultural aspects or the Deaf community and lower case when
referring to the audiological condition of deafness.
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HyperSign was written to address some of the needs of sign language learners. Specifically, we feel these
needs include:

• repeated exposure to the sign vocabulary (learners retain signs that they use frequently)
• exposure to Deaf signers in order to learn the appropriate, correct signs
• extensive practice reading and using signs in many different contexts
• an opportunity to see the motion of the sign
• an opportunity to view and review the suprasegmental aspects of each sign which can change the

meaning of the base sign
• an understanding of the rules which govern the use of signs
• an understanding of the culture of Deaf persons
• access to on-demand individualized, private, and self-paced instruction for peers and family members

The signs used in HyperSign were taken from the curriculum of A Basic Course in Communication (NAD)
and were recorded at NTID by Deaf and hearing members of the Sign Communication Department. The
authors of this program, as well as the members of the Communication Training Program at NTID, realize
that ASL dialects exist. Some sign synonyms
are signed in ASL and SEE.

Learning Features of HyperSign

Under no circumstances are we suggesting that a person can learn and be proficient in sign language
simply by using this program any more than any dictionary can be used solely in teaching any language.
Nor are we suggesting that persons using this dictionary could or should replace professional interpreters
who, alone, can provide Deaf persons access to clear and complete communication skills.

HyperSign was developed to meet many of the needs we perceived as hearing people attempt to learn a
language of another culture ... a language very different in content, form, and use from English or other
spoken languages.

While this product is centered around a video dictionary of approximately 2000 basic ASL signs, many
features have been included to enhance the learning experience and increase the potential for success in
learning, retaining and using ASL. Some of the features that we feel set this program apart from others are
outlined below.

• Full Motion Video
The full motion video of ASL signs include the suprasegmental features (facial expressions or gestures
accompanying the sign) which change their meanings. Each sign has a base sign representing the one
most commonly used in daily conversation.  If there is more than one sign which fits that word, the
dialectical or semantic variations of the signs are also available.

• Age Level Specific Vocabulary
Since vocabulary varies with age, HyperSign provides access to the video dictionary at three levels. Users
of the adult’s dictionary have access to all 2000 signs. The teen dictionary is a subset of the adult dictio-
nary. The child’s dictionary was specially designed for nonreaders and pre-readers with each word accom-
panied by an easily recognizable picture.

• Spanish and English
Since Spanish is the second most commonly used first language in this country, the program is designed
to provide instructional text in either Spanish or English.

• Activities
Games are fun. They enhance the learning process and they increase retention. We have included games
for children (Which One?, Matching Game and Tic Tac Toe), and teenagers and adults (Crossword Puzzle,
Name That Sign , What’s My Sign?, and You First!).

• Custom Word Lists
Often teachers or parents will want to focus attention on certain specific lists of words. This program
allows teachers or parents to create lessons containing specific lists of signs selected from either the
adult, teen or child’s dictionaries for classroom or in-home use.
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• Everyday Phrases
Language learning includes more than learning the words of a language. The words need to be combined to
form sentences. We have included a number of everyday phrases chosen to give users something to say.

• ASL Conventions
All languages have rules: rules of grammar and rules of usage. Some of the rules that govern the use of
ASL have been included in an on-line document titled More Than Meets the Hand: A Guide for New Users
of ASL which offers both written and signed examples of the uses of ASL.

• On-Line Bibliography
Language learning is enhanced if (or incomplete unless) the features of the culture are known. The culture
of Deaf persons is just beginning to be appreciated and studied. Deaf persons usually learn about their
culture from their Deaf peers since only 3% of Deaf children have one or more Deaf parents. As a service
to teachers and especially parents, an extensive bibliography on Deafness and Deaf Culture is accessible
from the program. This bibliography includes books for children, sign language learning books, books
about deafness, videotapes, etc.

Potential Users and Suggested Uses

There are many potential beneficiaries of a program that could be used to effectively learn ASL. Listed below
are some of the groups of people we think could benefit from this program and what we think their benefit
might be. This list is certainly not exhaustive.

• Family Members of Hearing-Impaired Children (grandparents, aunts,uncles, cousins, mothers,
fathers, sisters, brothers)
Since communication is the key in the life of a family, we consider this the most important user group for
this product.

Years of experience have shown that fluent, effective communication is a primary concern of the parents of
hearing impaired children. Parents often feel they can’t communicate with their hearing-impaired child
(How could s/he hear what I am saying?) or that the signs they use will not be correct. This is especially
frustrating since early stimulation and communication is a necessity in establishing the parent-child bond
and building a foundation for skills learned later in life. Children learn about the world and themselves
through language.

It is often difficult for parents to schedule time to take sign language classes and the classes themselves
are often intimidating. Parents are often afraid to imitate, ask for repetitions, or try out their skills at home.

This program provides a confidential, self-paced learning tool for parents and other family members. It
allows them to design their own lessons and practice at home and provides instant access to signs they
need in the home ... not merely those listed in a book or taught in a class.

• Medical Care-givers Working with Doctors or in Hospitals
These personnel may have contact with Deaf persons in both emergency and non-emergency situations.
A knowledge of the basic vocabulary relating to illness and injury would make their care of Deaf individuals
more effective and more efficient. Deaf persons would also feel less threatened if someone in the medical
environment could communicate with them until a professional interpreter arrived.

• Peers (Playmates) of Hearing-Impaired Children
Through play children learn about things and how they work. Important social skills including sharing,
rules, competition, losing, and negotiating are also learned through play. Piaget said “play is a child’s
work”. Even though language is not a prerequisite for play, it enhances the value of play and stimulates the
development of interpersonal relationships.

• Classroom Teachers and Other School Personnel
Since the passage of PL 94-142, the Education of All Children Act, in 1972, handicapped children,
including Deaf children, are mainstreamed into neighborhood schools.



Personal Version  •  Page 5

Even though Deaf children are provided with professional interpreters, they still report feeling like outsiders
in school. These feelings of isolation and loneliness could be significantly reduced if classroom teachers
knew and could use conversational signing and if other school personnel (cafeteria people, secretaries,
bus drivers, school nurses, playground supervisors, etc.) would learn basic conversational signs.

• Sign Language Learners
Learning sign language (or any language) is difficult unless there are opportunities for repeated exposure
to both the vocabulary and the rules of use. People also learn and retain vocabulary and language that
serve a purpose in their daily lives. This program provides a tool through which vocabulary can be learned
and reviewed.

• Pre-professionals or Professionals in Speech-Language Pathology, Audiology, and
Special Education
A familiarity with ASL would be advantageous for these professionals since professional interpreters are
usually not available when they are consulting with Deaf persons. In addition, sign language has also been
used successfully to establish communication with persons who are retarded, autistic, or who display
other problems which prohibit or impede ordinary spoken communication.

• Personnel Directors, Co-workers, Supervisors, and Managers
The implementation of ADA and the Equal Employment Act has increased the numbers of handicapped
(Deaf included) persons in the workplace. The ADA mandates that companies make certain that their
services are accessible to handicapped consumers.

While employment of Deaf persons has increased, these employees often report feelings of isolation and
loneliness unless there is someone with whom they can communicate. Although interpreters should
always be used for job related communication, the learning of basic conversational signing by employers
would send a positive message concerning a company’s commitment to making their Deaf employees feel
more comfortable and an integral part of their own workplace.

Not surprisingly, some business people have found that training their sales staff in basic sign communica-
tion not only generates good public relations but also increases their sales. Such a practice sends the
message that the owner values the business of the Deaf customer.
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Minimum Hardware Requirements

• 386DX/33 MHz with 8 MB RAM (16 MB recommended)
• 6 MB of free hard disk space
• 2X (minimum) CD-ROM drive
• VGA monitor running in 256 colors (thousands of colors recommended)
• Windows 3.1 or Windows 95/98
• Windows compatible sound card
• QuickTime™ for Windows

Installing HyperSign

Place Installation Disk #1 in your disk drive. Choose Run... from the File menu (Win 3.1) or click on the
Start button and choose Run... from the Start Menu (Win 95/98/NT/ME). Enter X:\SETUP (where X: is the
drive designation of your disk drive) and click on the OK button. Follow the on-screen prompts.

Checking Your Video Drivers

The video used in HyperSign are in the QuickTime™ format and require the 16-bit version (Version 2.x) of
QuickTime for Windows. If you do not have this version of QuickTime installed on your system, you can
install it from the HyperSign CD. Open the HyperSign CD and then open the folder HSUTILS. Double click
on the SETUP.EXE program to install QuickTime for Windows on your computer.

Starting the HyperSign Program

Make sure the HyperSign CD is in the CD ROM drive. If you are running Windows 3.1, open the HyperSign
program group and double click on the icon for the HyperSign program. If you are running Windows 95/98/
NT/ME, click on the Start button, choose Programs from the Start menu, select HyperSign and finally
choose the HyperSign menu item. The main HyperSign dictionary window is displayed.

Setting the Program Preferences

Select Preferences... from the File menu. The features offered here deal with the dictionary displayed when
the program first starts, the language used and the sound options. Whenever you save the preferences, your
selections become the default or start-up settings for the program.

Age at Start-Up

The first thing to specify is the default dictionary which determines what the main dictionary screen looks
like (child, teen or adult) and the vocabulary available when the program starts. This option takes effect the
next time you start HyperSign. Click on the appropriate age icon to select the default dictionary. If the child
dictionary is the default dictionary, you must enter the password (hypersign) to change to the teen or adult
dictionaries. When the teen dictionary is the default dictionary, you must enter the password to change to
the adult dictionary.

Language

The language option determines the language used in the menu items and for the written words
accompanying the signs. Select the language (English or Spanish) you prefer from the pop-up button.

Sound

The program provides audio responses (bell and buzzer sounds, etc.) to user’s answers in the various
activities,  Clicking on the Game Feedback check box toggles this option on (a √ is displayed in the check
box) and off. Use the slide bar to set the default volume and click on the picture of the little girl to hear a
phrase spoken.

Chapter 2
Getting Started
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The Help Menu

General and activity specific help are available from the Help menu. The actual help screen displayed
depends on the dictionary you have open. In addition, the program provides specific help on the Preference
and the Student Sign In screens.
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HyperSign is a dictionary of approximately 2000 basic signs of American Sign Language. The adult dictio-
nary allows unrestricted access to most of the signs. The teen dictionary and activities are identical to those
available to adults with the exception that the dictionary is a subset with certain words removed that the
authors felt were inappropriate.

The Adult/Teen Dictionaries

Click on a letter above the scrolling field on the left to show the dictionary entries associated with that letter.
The sign for words displayed in all capital letters are the gloss (the sign most frequently used for that word).
Words followed by (a), (b), etc. are signed by different persons or are variations of the sign. Any of these
variations is acceptable.

When you click on a word or phrase in the scrolling field, the program displays the movie for the sign in the
movie window (clicking on the left-most button below the movie window plays the entire movie) and its
English name and other words sharing the same sign beneath the movie window. For example, if you
selected the word “rural”, the English name of the sign is “country” and the words “rural” and “country” both
share this same sign.

Chapter 3
Adult/Teen Dictionary & Activities
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You can also use the Find option to find words in the dictionary. Click in the text box to the right of the Find
label, type in the word you want to find, specify if you want to match parts of words or whole words and then
click on the Find button. The program searches the dictionary, loads the matches in the pop-up button
labelled Matches, and highlights the first match in the appropriate dictionary index card.

Here is an example. Type in the word room and click on the Find button. After the search is complete, the
dictionary index card is refreshed and the first entry, bathroom, is highlighted. If you click on the pop-up
button below the Find button, six entries are listed. You can select the word whose sign you want to view
from this pop-up button or from the dictionary index card.

That’s all there is to using the HyperSign dictionary. It is very easy and yet very powerful. If you need any
kind of help or are having difficulties, check the Help menu at the right of the menu bar.

The Adult/Teen Activities

Learning sign language is not just watching a TV screen and drilling and practicing. To add diversity and
excitement we have also included a variety of activities for each age group as options on the Activities menu.

Crossword Puzzle

When Crossword Puzzle is chosen from the Activities menu, the crossword puzzle screen is displayed
with the default game, constructed from the current activity word list, chosen. Below the movie window are
numbered buttons representing the ACROSS and DOWN words.

Click on the corresponding numbered button and then the movie Play button to see a clue for a word in the
puzzle. After viewing the movie clue, type the name of the sign in the boxes below the crossword puzzle and
click on the Check Answer button. If you are correct name, the letters will be entered in the crossword
puzzle. If you have entered an incorrect answer, a message is displayed. After two incorrect responses, the
correct answer is entered into the puzzle in red. You can review the movie by clicking on the Play button.
When you are ready, select another across/down button and continue until you complete the entire cross-
word puzzle.

After the puzzle is solved, you can play again by clicking on the New Puzzle button to clear the screen and
display a new puzzle constructed from the current word list. If you want to try a puzzle based on a different
category of signs, click on the Current List pop-up button and select the category of your choice.
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Name That Sign

This activity is similar to the crossword puzzle in that you are shown a movie and you must enter the name
of the sign. However, this is a little more difficult because you don’t have any clues as to how many letters
are in the name of the sign.

View the movie clue by clicking on the movie Play button. Then, enter the name of the sign in the box on
the left and press the Enter key. You have two chances to correctly name the sign. A tally of your re-
sponses is displayed on the Score Board below the movie window.

Each game consists of the number of signs in the current word list or a maximum of 10 randomly chosen
signs if the word list has more than 10 signs. The number of signs (items) in the chosen category is dis-
played in the heading above the Current List pop-up button. Clicking on the New Game button starts a
new game based on the current word list or you can choose a different category of signs from the Current
List pop-up button.

What’s My Sign?

In this activity you view a sign movie and identify which sign was played by choosing its word equivalent
from the 3 choices offered. You will be told if your answer was correct or not. After two incorrect answers,
the correct answer is highlighted. Click on the Next Sign button for the next sign.
A tally of your responses is displayed on the Score Board. Clicking the New Game button starts a new
game based on the current word list or you can choose a different category of signs from the Current List
pop-up button.
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You First!

This exercise has been included to provide practice making the signs. In this activity you are shown a word
and you are to make the sign for that word. The computer will wait 3 seconds for you to make the sign.
Check the accuracy of your signing by watching the sign movie. Then, evaluate (objectively, of course) how
well you did by choosing Yes or No on either side of the phrase “Were you right?”.

As in each activity, each game consists of the number of signs in the current word list or a maximum of 10
randomly chosen signs if the word list has more than 10 signs. The signs are randomly selected so you can
practice the signs in any category as many times as you wish. You can easily choose a different category
of signs by clicking on the Current List pop-up button.

Vocabulary Review

Here you review the signs included in each category. Choose a category from the Current List pop-up
button to display the words in the list in the scrolling field. Click on a word in the scrolling list to display the
name for the sign and any other words or phrases that share the same sign beneath the movie window and
the first frame of the movie in the movie window. Use the movie controls to play the movie. The word list
chosen when you leave the review section is the default word list used in the other games.
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The Adult/Teen Extras

HyperSign offers some special features on the Extras menu including a unit on fingerspelling, everyday
phrases, and some information and examples of how to use ASL (Conversing in ASL).

Fingerspelling

The fingerspelling module helps you learn to form the hand-shapes for each letter of the alphabet.
Fingerspelling is used by Deaf persons to spell a proper noun (the name of a city or person), or a word
which has no sign. The beginning signer will use fingerspelling a great deal until his/her vocabulary of signs
is large enough for conversational purposes.

The Fingerspelling screen shows the letters of the alphabet and the movie window. When you click on a
letter on the left of the screen, that letter and a few words containing that letter are listed below the movie
window. Click on an item in this list and then the Play button to see the letter or word fingerspelled.

By watching these words spelled you can see how the hand-shape for the letter you have chosen is formed
when it occurs with other letters. This will also give you practice in reading someone else’s fingerspelling.

Everyday Phrases

After learning a few signs and some fingerspelling, you will want to use your signing skills with a Deaf
person. You can use the phrases in this exercise to practice understanding someone else’s signs and
putting signs together.
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These phrases are signed by a teenager and an adult and they may sign some of the phrases a bit differ-
ently. The adult is using pure American Sign Language and the other is using American Sign Language
signs and putting them into English. Deaf persons understand  either version.

Click on a phrase in the scrolling list and the first frame of the movie will be displayed in the movie window.
Click on the Play button to see the whole phrase signed.

Conversing in ASL

Before you begin using ASL with Deaf persons, there are some rules of conversation you will need to know.
Like any other language, ASL has rules that govern who talks, when to talk, how to introduce yourself, and
how to change the topic of conversation.

While it was not our intent to include all these rules, those you need as you start to learn and to use sign
language are discussed when you select Conversing in ASL from the Extras menu. On the top left of this
screen is a pop-up button from which you can select a specific topic. When you make a choice from this
button, the information relevant to that topic is displayed in the scrolling text field.

As you read about the different rules, you will notice that certain words or phrases are colored (red). If you
click on red colored word or phrase, the first frame of the movie that demonstrates that rule or concept is
shown in the movie window and a brief description is displayed under the movie window. Click on the Play
button to see the rule or concept demonstrated. Do this for all red colored words for each topic or rule.

Bibliography

It may be helpful to the sign language learner to have access to books, videos, and other reference materials
that describe deafness and Deaf culture. Included with HyperSign is a bibliography of about 200 references
to enhance your learning of sign language and Deaf culture.

When you select Bibliography from the Extras menu, a form view of the bibliography is displayed with
fields (category, title, authors, source, citation, year of publication, key words and comments) filled with data
from the first entry in the database.

As you browse the database, you can mark entries you want to save or print out by clicking on the Marked
check box to the far right of the record category. If an entry is marked and you want to un-mark it, click on
the Marked check box again. All the references marked in this manner can be viewed, saved as a text file,
or printed out as a group.
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Click on the View List button. In the list view only the title, author and year are displayed. You can still
mark records on the list view by clicking in the left-most column opposite the record you want to mark.
Marked records display a bullet (•) in this column. To un-mark a record in the list view, just click in this
column again and the bullet will be removed. If you double click on a record in the list view, the form view is
displayed with the information from the selected record filled in.

You can use the search capabilities to find all the records pertinent to a specific topic. Click on the Search
Records button  Then:

1) First choose the field (category, title, author, source, citation, year, keywords, comments) to compare
from the first pop-up button.

2) Then select a how to compare (contains, doesn’t contain, is or isn’t) from the second pop-up button.
3) If the field is “category” or “keyword”, choose what should be matched from a third pop-up button.

Otherwise, you type in what it is you wish to match in the text box in this slot.
4) Finally, click on the OK button. In the form view, the fields are filled with data from the first matching

entry in the database. Use the forward and reverse arrows to browse the matched records. All matching
records are displayed in this view.

Let’s look at an example. Suppose you wanted to see all the records in the database that have the word
“deaf” in their titles. You would choose “Title” from the first pop-up button, “contains” from the second pop-up
button and  type “deaf” into the third slot. When you click on the OK button, the first matched record is
displayed and the tally at the bottom of the screen shows that you are viewing match number 1 out of 89
matched records found.

You can further narrow a search by filling in the lower set of pop-up buttons on the search dialog screen.
When you specify two sets of matching criteria you must also specify whether you want to find all the
references that match both of the criteria (click on the And radio button) or only those references that match
either of the criteria (click on the Or radio button).

You can print out records you are interested in or save them as a file. Click on the Print/Save Records
button. Specify the items you want to appear in the report by clicking on the desired item in the text field on
the left, holding down the mouse button, dragging it to the text field on the right and releasing the mouse
button. Next, decide if you want the report to include the currently selected record (the one displayed in the
form view or highlighted in the list view), all the matched records or just the records you have marked. Just

List View Print/Save Records Next Record
Form View Previous Record

Search Records Show All Records
Show Marked Records
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click on the button of your choice. Finally, click on the Print button to print out the report or the Save to
Disk button to save the report as a text file on disk which you can open in a word processing program. If you
choose this option, a standard save dialog box is displayed. Name the file, choose where you want it saved
and click on the OK button.

When you are finished printing or saving reports, click on the Done button to dismiss the print dialog box.
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The Child’s dictionary was specially designed for nonreaders and pre-readers. If HyperSign is going to be
used predominately by children fitting into this category, you should set the preferences (see page 8) so that
the Child’s Dictionary is automatically displayed when the program starts. If you have started HyperSign and
the Adult/Teen ASL Dictionary screen is displayed, choose the Child item from the Dictionary menu.

The Child’s Dictionary

The Child’s dictionary provides a visual interface. Each word in this dictionary has been carefully chosen so
that it can be accompanied by an easily recognizable picture (from the Mayer-Johnson library).  The words
were chosen from the text Basic Vocabulary and Language Thesaurus for Hearing-Impaired Children by
Daniel Ling and Agnes Ling (Alexander G. Bell Association for the Deaf, Washington, D.C., 1977).

The vocabulary has been grouped into 26 categories, each containing about 25 words. Each category title is
represented in picture and written forms.

Child’s Dictionary Categories

Action Words (a-g) Everyday Verbs (h-z) People
Action Words (h-z) Family Places
Animals Foods Pronouns
Body Fruits & Vegetables School
Clothes Holidays Time
Colors House Transportation
Descriptions (people) How Much When
Descriptions (things) Miscellaneous Where
Everyday Verbs (a-g) Outside

When the Child’s dictionary screen is displayed, the Action Words (A-G) book is removed from the book-
shelf. Click on the book cover to open it to the first entry (ask). The written form of the word is displayed on
the left-hand page of the open book and a picture of the word is displayed on the right-hand page.

Chapter 4
Child’s Dictionary & Activities
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Click on the little girl on the left page of the open book to have the word pronounced. Click on the picture on
the right page to show the first frame of the sign in the movie window. Clicking on the left-most button
beneath the movie window  plays the entire movie.

Click on the arrows on either side of the scroll bar beneath the book or on the dog-ear corners of the pages
to turn the pages of the book. Click the pop-up button at the far right of the scroll bar to display a list of all
the words in the book. Click on the word you are interested in and the book page changes to display the
word you selected.

The bookshelf contains other books organized by categories children easily recognize. Click on the arrows
below the bookshelf to choose a different book. Each time you click on these arrows, a new book is re-
moved from the bookshelf and its cover is shown. When the book cover for the category of words you are
interested in is displayed, click on it to open it so you can page through the book and find the words whose
signs you want to review.

At the far right of this scroll bar is a pop-up button. Click on this button to display a list of all the categories.
Click on the category you are interested in and the book cover for that category will be displayed.

To find a word quickly, type it in the text box above the Find button and press the Enter key. The program
will search the dictionary and, if the word is found, display the appropriate book opened to that word.

That’s all there is to using the Child’s Dictionary. It’s easy and children have no problem finding words they
are interested in and viewing the signs.

The Child’s Activities

Learning sign language is a lot of fun for children. To add to the excitement of learning a new language we
have included three activities especially designed for children. These are available from the Activities menu.

Which One?

This game gives children additional practice on recognizing signs and is appropriate for even very young
children. When you choose Which One? from the Activities menu, a new screen is displayed with 3
pictures in the middle of the screen and the movie window on the right. Click on the Play button beneath the
movie window to see a person signing one of the words represented by the pictures.

You can view the movie as many times as you wish. When you recognize the sign, click on the picture
representing the sign from the three choices. If you are correct, the happy face lights up, a bell rings and a
happy face is displayed in the counter under the faces. If you are wrong, the sad face lights up and a
message is spoken. No marker is placed in the counter. After two wrong guesses, the picture for the correct
answer is highlighted and the movie showing the sign is played before proceeding with the game.
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Each game consists of nine questions unless there are fewer than nine items in the chosen word list. After
the completion of the game, you can play another game with the same list by clicking on the New Game
button or choose a different group of signs from the Current List scrolling field just below the movie window.

Tic Tac Toe

Children of all ages know how to play Tic Tac Toe. HyperSign’s version of Tic Tac Toe is a little different in
that the goal is to help children learn various signs within the context of this familiar children’s game. When
you chose Tic Tac Toe from the Activities menu a screen is displayed showing the typical “tic tac toe”
game board with all nine spots occupied with the same picture of a little girl.

To start the game, click on the picture occupying the position on the game board you would like to place a
“happy face”. The program places a question mark in the chosen position on the game board, displays three
pictures in the boxes below the game board and displays the first frame of a movie in the movie window.

To place a “happy face” in the chosen game board position, you need to identify which of the three pictures
represents the sign shown in the movie. Click on the Play button to view the sign. Then click on the picture
that represents the sign shown. You get two chances to identify the correct picture. If you correctly identify
the sign, a “happy face” is displayed in the chosen game board position; if you are incorrect, a  “sad face” is
displayed.

The game continues while you try to get three “happy faces” vertically, horizontally, or diagonally. After the
completion of the game, you  can choose to play another game with the same word list by clicking on the
New Game button. Since most lists will contain more than nine signs and the signs are presented ran-
domly,  you can play the game with the same list many times and continue to see different signs. The
Current List scrolling field offers other lists of related signs for use in this game.

Match Game

This game is a little more difficult. Children will learn signs as well as the fingerspelling alphabet while
playing. When a child selects Match Game from the Activities menu, a new screen is displayed showing
12 small squares. Behind each square is a picture of a fingerspelled letter of the alphabet. There are 6 pairs
of matching pictures hidden on the game board.

The first challenge is to find matching pictures of the fingerspelling alphabet. To do this, you click on two of
the game board squares. If the two picture don’t match, the sad face is highlighted and the pictures are
covered up. If the two pictures match, the happy face is highlighted, a bell rings, the two pictures are moved
to the box above the game board.
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Matching all 6 pairs uncovers a fingerspelled word on the game board, displays three pictures in the boxes
below the game board and the first frame of a movie is displayed. If you click on the little-girl button in the
center of the game board, the word will be fingerspelled. You can also click on the Play button to view the
movie of the sign. In order to win the game, you must identify the fingerspelled word by clicking on the
picture that correctly represents it.

After the completion of the game, you can choose to play another game by clicking on the New Game
button or choosing a new word list from the Current List scrolling field.

Learn the Words

This activity is provided so that children can view and practice the signs that make up the specific lists used
in the other Activities. This is especially useful if an adult or instructor has created special lists for the
children to use in the Activities. (See Chapter 5 for a discussion on how to create specific lists of words for
different Activities.)

When you choose Learn The Words from the Activity menu, a screen is displayed that is similar to Child’s
Dictionary screen. At the left is a field listing all the currently available lists of words. Below the movie
window is the familiar open book showing the written form of the word on the left-hand page and the pictured
form on the right-hand page.

If you click on the little girl icon on the left-hand page of the open book, the word is pronounced. If you click
on the picture on the right-hand page of the open book, the first frame of the sign will appear in the movie
window. Beneath this window are the buttons for controlling the movie. Clicking on the Play button plays the
entire movie.
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To turn the pages of the book, click on the arrows on either side of the scroll bar beneath the book or on the
dog-ear corners of the pages. At the far right of the scroll bar is a pop-up button. Click on this pop-up button
to display a list of all the words in the chosen list. Click on the word you are interested in and the book page
changes to display the word you selected.

The Child’s Extras

HyperSign also includes units on fingerspelling and  everyday phrases for children. These options are
available from the Extras menu.

Fingerspelling

The fingerspelling module helps children learn to form the hand-shapes for each letter of the alphabet.
Fingerspelling is used by Deaf persons to spell a proper noun (the name of a city or person), or to spell a
word which has no sign. The beginning signer will use fingerspelling a great deal until his vocabulary of signs
is large enough for conversational purposes.

The Fingerspelling screen shows the letters of the alphabet, the movie window and a scrolling text field
below the movie window. When you click on a letter on the left of the screen, the letter and a list of words
containing that letter are displayed. Click on the letter or one of these words in the list to see a signer
fingerspell that letter or word. By watching these words spelled you can see how the hand-shape for the
letter you have chosen is formed when it occurs with other letters. This will also give you practice in reading
someone else’s fingerspelling.

Everyday Phrases

After you learn a few signs and some fingerspelling, you will want to use your signing skills with a Deaf
person. When you select Everyday Phrases from the Extras menu, a list of common phrases is displayed.
You can use these phrases to practice understanding someone else’s signs and putting signs together.

Click on a phrase in the scrolling list and the first frame of the movie is displayed in the movie window. Click
on the Play button to see the whole phrase signed.
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Word lists are used in HyperSign as a way of choosing sets of signs for the games and vocabulary review
items listed on the Activities menu. Word lists are groups of words that are in some way related to one
another. The relationship among the words is up to you. For example, teachers might want to build lists of
words and signs for their students to review or practice at a later time. Parents or teachers who have hearing
impaired children in their classes might want to build lists of signs specific for peers, grandparents, baby-
sitters, medical personnel, etc.

While HyperSign comes with a number of pre-built lists, this utility allows you to edit the pre-built lists or
create your own. Access to this program is password protected to prohibit access by unauthorized users.
To gain access to this program, start the program, select Enter Password... from the File menu and enter
the password hypersign .

With this program you can build lists for adults, teens or children using a sinple four-step process:

Step 1 Selecting the Dictionary & Language

Select the dictionary you want to edit from the Dictionary menu. Select the language by clicking on
the appropriate radio button at the top tright of the screen.

Step 2 Choosing, Creating or Deleting Activity Word Lists

(a)  Creating a New Activity Word List

Select New Activity Word List... from the File menu. Enter the name of the new list in the dialog
box and click on the Add List button. This creates a new, empty list. You may continue adding new
lists. When you are finished, click on the Done button. Note, you must create and name an Activity
Word List before you can add words to it.

(b)  Choosing an Activity Word List for Editing

To choose a list for editing, select Open Activity Word List... from the File menu, click on the
name of the Activity Word List you wish to edit and then click on the OK button. The name of the
list selected is displayed at the top right of the screen and the words in the list are shown in the
scrolling field on the right of the screen.

Chapter 5
The Activity Word List Manager Utility
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(c) Deleting an Activity Word List

Choose Delete Activity Word List... from the File menu. A dialog box is displayed with all the
activity word lists in a scrolling field. Click on the name(s) of the activity word lists you wish to
delete. When you click on a name in the list, a red Del flag is displayed just to the left of the list
name. If you change your mind about deleting a particular word list, just click on its name again to
toggle the Del flag off. After marking all of the lists you wish to delete, click on the Delete Lists
button and confirm that you wish to delete these lists.

Step 3 Adding (or Removing) Words to an Activity Word List

After selecting an activity word list, the words in the list are displayed in the scrolling field at the
right of the screen and you can proceed to add or remove words to this list.

To add a word to the named list, you first find the word in the dictionary at the top left of the screen
or use the Find a Word item on the Options menu. Once you have found the word you want to add
to the list, click on it in the scrolling field on the left, hold down the mouse button, drag it to the
scrolling field on the right and release the mouse button. You can continue to add as many words to
the list as you wish. All changes are automatically saved.

To remove a word from a list, click on it in the scrolling field on the right, hold down the mouse
button and drag it to the trash can. No confirmation is required.

You may view the sign movie of any of the words in the scrolling field on the left of the screen. Click
on the word to highlight it and then choose View Sign Movie... from the Options menu.

Step 4 Specifying Which Word Lists are Active in HyperSign

Select Choose Active Word Lists... from the Options menu to specify which word lists are active
in HyperSign Jr. A blue dot to the left of the name of the activity word list means that it is active in
HyperSign Jr. To activate an activity word list, just click on its name in the list. The blue dot will be
placed to the left of its name. To deactivate a particular word list, click on its name again and the
blue dot will be removed.

For the Adult and Teen dictionaries you can specify as many word lists as you wish to be active.
However, you can only specify a maximum of nine activity word lists as active at one time for the
Child dictionary. You can, of course, change the active lists at any time using this option.

Designating Alternate Pictures and/or Recordings

Each word in the Child’s Dictionary has a picture and recording associated with it. Both the picture and
recording are used in the main dictionary page and in the Learn the Words activity. The pictures are also
used in all of the other Activities (games). Some users may want to use different pictures or different
recordings for a particular word in the child’s dictionary and so you have the option of designating an alter-
nate picture or recording for any of the words child’s dictionary.

Choose Assign Alternate Wav/Picture... from the Options menu to display a dialog box. In this dialog box,
the word (or phrase) from the Child’s Dictionary is displayed at the top. On the left is a button to play the
default recording for this word and default picture is displayed at the bottom. If there is an alternate recording
(WAV file) clicking on the radio icon in the middle of the dialog box will play it. And, if there is an alternate
picture (BMP file) for this word it is shown at the bottom-middle of the screen.

Only one alternate recording and/or picture can be assigned to a word. If you have defined an alternate
recording or picture and chosen to use it, the Alternate WAV  (and/or Alternate BMP ) radio button will be
checked. To use the alternate recording and/or picture, make sure the Alternate WAV  and/or Alternate
BMP radio buttons are checked and click on the Done  button.
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Alternate Recordings
The alternate recordings must be WAV files. You can create these recordings using the Sound Recorder
utility (click on the Start  button and choose Accessories|Multimedia). You can also click on the Record
button (top, right) and make your recording from within this program. If you make a recording in this way,
it is automatically stored in the TempWavs folder (located in the HyperSign folder on your hard drive).

To use a recording you have made as the alternate WAV, click on the Browse for WAVs  button, navigate
to the folder where you have saved the recording, click on any WAV file and then click on the OK button.
All of the WAV files in the folder selected will be displayed in the scrollable field at the top right of the
screen. Click on one of these to highlight it and click on the icon of a radio to hear it played back.

To use this alternate recording, make sure the Alternate WAV  radio button is checked before you click
on the Done  button. After clicking Done, the program will copy the WAV file to the Altfiles folder and
name it so that it is recognized by the HyperSign program.

Alternate Pictures
The alternate pictures must be BMP files. You can create these pictures using your Paint program if you
choose. Ideally the BMP file should be 135 x 115 pixels (width x height).

To choose a picture as the alternate BMP, click on the Browse for BMPs  button, navigate to the folder
where you have saved the pictures, click on any BMP file and then click on the OK button. All of the
BMP files in the folder selected will be displayed in the scrollable field to the bottom right of the screen.
Click on one of these to highlight and display it. To use this alternate picture, make sure the Alternate
BMP radio button is checked before you click on the Done  button. After clicking Done , the program will
copy the BMP file to the Altfiles folder and name it so that it is recognized by the HyperSign program.

Restoring Defaults
If you wish to restore the default recording and/or picture, make sure the Default WAV  radio button (and/
or the Default BMP  radio button) is checked and click on the Done  button. When the default recording
(and/or picture) is restored, the alternate recording (and/or picture) is irreversibly removed from the
Altfiles folder.
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Trinity Software License

The software is protected by the United States Copyright Laws. This software may be used by any number
of people and may be freely moved from one computer to another so long as there is no possibility of it
being used by two different people at two different locations at the same time.

Copyright © 1997, 1999, 2001  •  All Rights Reserved
Doug Martin, Ph.D. and Ann K. Lieberth, Ph.D.

ISBN 0-927365-53-7

Published by Trinity Software, Inc.
607 Tenney Mountain Highway • Suite 25 • Plymouth NH 03264

Web Site: www.trinitysoftware.com
Sales: 603-536-9661 or 800-352-1282

Tech Support: 888-874-6484 (support@trinitysoftware.com)

Copyright Information

MS-DOS and Windows are trademarks of Microsoft Corporation.

QuickTime is a registered trademark of Apple Computer, Inc.

The signing videos used in HyperSign were digitized from the laser disc produced by the National Technical
Institute for the Deaf, Rochester, NY and are used with their permission.

The pictures in the Child’s Dictionary are taken from the BoardMaker Library produced by the Mayer-
Johnson Company, Solana Beach, CA and are used with their permission.

Chapter 6
Software License & Copyright Information
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The following are the most common issues raised with technical support for HyperSign and the recom-
mended solutions.

1) A system error is displayed when the program tries to display a video clip.
The video used requires QuickTime for Windows. If the QuickTime for Windows driver is not installed on
your computer system, from File Manager (Windows 3.x) or Windows Explorer (Win 95/98), open the
HyperSign CD and then open the folder HSUTILS. Double click on the QTINSTAL.EXE program to install
QuickTime for Windows on your computer.

2) When I try to play a video I get a fatal exception error message and blue screen.
This problem has been reported by some users with Pentium II and Pentium III processors. The folowing
work-around seems to work in all cases. There are 2 places where changes need to be made: (a) in the
Quicktime Control Panel and (2) in the QTW.INI file (in the WIndows folder):

a) Changes to the Quicktime Control Panel:
1. Click on Start button. Choose Settings|Control Panels
2. From the control panel screen, double click on the quicktime icon. (If you have icons for both

QT32 and QT16, double click on the QT16 icon.
3. Click on the More button at the bottom right of the dialog box displayed. This will display some

tabs at the top of the dialog box.
4. Click on the Video tab.
5. In the middle of the dialog box is an area called Optimization and a scrollable field showing the

various Draw Methods available.
6. Click on (highlight) the Windows DIB item in this scrolling field. (If this doesn’t work, select the

RAW item in this field.)
7. Click on the Apply button at the bottom of the dialog box.
8. Click on the Close button at the bottom of the dialog box.

b) Changes to the QTW.INI file:
1. Open the QTW.INI file in the Windows folder in NotePad.
2. Under the [Video] section, change the optimize value to RAW (others have used Driver), that is,

Optimize=RAW
3. Save the changes.

Restart your computer. You may have to try a couple of different setting to resolve this problem.

3) I get error messages saying that a variable has been set to a null value or that the variable is out
of range.
This error has only occurred with Windows 3.1 users. The program makes extensive use of a variety of
databases and the database engine employed requires that the SHARE.EXE program is running. Refer
to your MS DOS Reference manual for the correct method for installing SHARE.EXE on your system.

4) The screen flashes when changing activities and the videos aren’t very clear.
This occurs when your system is configured to display 256 or fewer colors. The only way to fix it is to
set up your system to display more than 256 colors. Open the Start Menu and choose Settings: Control
Panels. Then open the Display control panel. Click on the Settings tab at the top, right of the control
panel. Then, set the Color Palette to at least high color (16 bit). Close the control panel.

Chapter 7
Common Problems & Solutions
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5) The bottom of the HyperSign window seems to go off the bottom of the screen.
This occurs when the Windows 95/98 task bar covers up the bottom of the HyperSign window. To
correct this, open the Start Menu and choose Settings: Taskbar. Then make sure the Auto hide check
box is checked. Now the Taskbar should be hidden and the entire HyperSign window will be visible. To
access the Taskbar, just move the cursor to the very bottom (by default) of the screen and the Taskbar
will appear.

If you need further help or have other questions regarding technical support, please send an e-mail message
to support@trinitysoftware.com. Be sure to specify that you are using HyperSign For Kids and carefully and
completely describe the problem you encountered.

revised 7/2001
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How to Best Use Our Technical Support Staff

1. First check the manual and the README file. This file, if present, contains updated information not in the
manual.

2. If you still need technical assistance, help is available by:

MAIL: Technical Support, 800 Virginia Avenue, Suite 52
Fort Pierce FL 34982

FAX: Trinity Software at 561-464-6703
PHONE: Trinity Software at 888-874-6484 between the hours of

9 am and 5 pm EST from a phone next to your computer.

How to Prepare for Technical Support

If you have the following information written down before contacting our Technical Support Department, we will
be able to help you more easily.

1. Product name and Version Number (usually on the program’s Title Page and/or the disk label)
____________________________________________________________________________________

2. Product Registration Number
____________________________________________________________________________________

Computer Name and Model
____________________________________________________________________________________

Operating System and Version Number
____________________________________________________________________________________

Type of Audio Input Device
____________________________________________________________________________________

Type of Printer
____________________________________________________________________________________

3. Does the problem occur only on this one machine? If yes, is there anything peculiar about this machine?

4. Write down the exact wording of any error messages displayed.

5. To correct problems we must first be able to reproduce them, Describe the problem accurately. Explain
carefully when and where it occurs. Can you consistently reproduce the problem? If yes, specifically how?

Technical Support


